
 
 

 
 

Autodesk Impression 3 
Dress Your Designs to Impress with Autodesk 

Impression 
Kristina Bollin 

S1-5 
 

 Course Summary: 
Feeling intimidated by advanced photorealistic renderings? Or perhaps you just appreciate the hand-drawn 
characteristic of traditional visualization methods.  Discover how Autodesk Impression can help anyone who’s 
interested in creating quick, simple renderings that look great and preserve a traditional feel.  This course will 
cover topics from the basic interface of Impression to creating your own signature styles, and nearly 
everything in between.  You’ll learn step-by-step how to create a rendering and then apply the same 
appearance to multiple views within minutes.  This jam-packed session will leave you feeling like the Cézanne 
of Impression-ist visualization. 

 

   

 Instructor:  
Ms. Bollin is a Technical Specialist in Design Visualization for US CAD with 4 years of CAD experience.  Prior 
to joining US CAD, she worked as a drafter for the Engineering and Architectural Services Department at 
Michigan State University, while earning her Bachelor of Arts degree in Interior Design.  She was also a 
student teaching assistant for AutoCAD classes at MSU.  She utilizes Revit Architecture and AutoCAD 
Architecture to create drawings for design development and construction documentation.  Additionally, she 
uses 3DS Max Design and Autodesk Impression for design visualization, as well as NavisWorks for BIM 
collaboration projects 
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Introduction 
You don’t have to be a design visualization expert to create presentation-ready graphics that will 
impress your colleagues and clients (and most importantly, win those projects!).  This handout will 
help you get familiarized with the easy-to-use Autodesk® Impression design presentation software. It 
also includes more in-depth information about custom styles and block creation.  The goal of this 70 
minute session is to cover the topics necessary to help you get up and running in Impression and to 
teach you about the tools necessary to begin developing your own unique rendering style.  
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Overview 
I. Starting a New Rendering 

a. Setting up your DWG and DWF files 
b. The Import Wizard 
c. The User Interface 
d. Filling In the Blanks 

II. Endless Possibilities with Custom Styles 
a. Style Organization 
b. Editing Options 
c. Style Library Wizard 
d. Saving Styles 

III. Taking it a Step Further with Custom Blocks 
a. Overview of Impression Blocks 
b. Creating a New Block 
c. Editing Blocks 

IV. Completing a Rendering 
a. Re-creating your Style 
b. Export Options 

V. Demonstrations 
a. Overview of the User Interface and opening a DWG 
b. Styles 
c. Blocks 
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Starting a New Rendering 
a. Setting up your DWG and DWF files 

Impression supports DWG and DWF files without the need for file conversion.  To produce a 
more efficient workflow, there are a few things you can do to prepare your DWG or DWF file 
before bringing it into Impression.  Here are a few suggestions: 

i. Closed Areas:  Although you can fill in areas that are not closed in Impression, 
it’s best if you minimize the amount of gaps in areas you intend to fill (don’t forget 
about the BOUNDARY command in AutoCAD)  

ii. Organize Layers:  Make sure your layers are organized according to your office 
standard, and that objects are on the correct layers.  Not only will this make it 
easier to render by layer within your Impression file (a topic we’ll cover later in 
this handout), but it will also be easier to re-create renderings with the same layer 
set up in the future. 

iii. Freeze or Turn Off Unwanted Objects .  In Impression, you can choose to 
exclude frozen layers when you open the DWG, which saves a lot of time in 
deleting unwanted objects in Impression. 

iv. Hatches : If you plan to use a style in Impression to replace a hatch from 
AutoCAD, remove it before you open the file.  Detailed hatches can slow down 
the loading and processing time within Impression, so try to stick with hatch 
patterns and styles that are native to Impression.   

v. Impression Toolbar: Loading this toolbar within AutoCAD provides access to a 
few Impression commands and creates a smoother workflow between the two 
applications.  Here’s how to load the toolbar into AutoCAD: 

Start Menu > Control Panel > Add or Remove Programs > AutoCAD  > 
Change/Remove > Add or Remove Features > Check the “Impression 
Toolbar” box under Features 
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b. The Import Wizard 

The Import Wizard is a dialog box that appears every time you open or import a DWG or DWF.  
There are two Import Wizards, one for DWG files and one for DWF files.  Both serve the same 
purpose: to guide you through the options to open, display, and improve the performance of 
your files in Impression.   

What to Open (DWG):  
Select to open a page layout, an individual viewport, 
or all of the objects in model space.   
If necessary, specify a Layout or Viewport 
Style Assignment (DWG):  
Choose to use a plot style to display linework from 
AutoCAD, or a uniform stroke type from Impression.  
    To display linework as shown in the original DWG file, 

select “None” for both options. 
Import Options (Both): 
Impression keeps the original DWG file’s scale.   
If desired, select a previous Impression file to copy its 
style maps into your new file.  If you will be using 
blocks from a previous Impression file, choose the 
“Mapping Options” to select the file that contains the 
desired blocks (Importing Maps will also be discussed 
later in this handout). If the DWG is from a 3D view, 
select “3D Import Options” and choose to display in 
wireframe or hidden line.  Lower the file size by 
removing geometry that is hidden. 
File Clean-up (Both):  
The more boxes you check here, the faster the 
loading time and file performance will be.  If you set 
up the DWG file properly, you should be able to check 
the three recommended boxes 

Pack Layers (Both):  
It is recommended that you choose “Pack all layers”, which combines objects on the same 
layer with the same style and turns them into one object. This will decrease the loading time of 
the file.  You have the option to unpack the layers once the file is open.  
Import Options (DWF): Select a uniform stroke type to assign to all linework, or “None” to keep 
original DWF appearance 
Mapping Options (DWF): select a previous Impression file to copy its style maps into your new 
file (Importing style maps will also be discussed later in this handout) 
One-Layer Drawings (DWF): Choose to create new layers (this option will simplify stylization of 
objects) or keep your DWF linework as a single layer 
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c. The User Interface 

There are three main areas of the Impression interface: the toolbox, the dashboard, and the 
canvas.  You can think of the toolbox as your tools, such as your paint brush and pens, and 
consider the dashboard as your palette of rendering media, or what you will use to “color” your 
image (watercolor, colored pencil, marker, etc).   

 
Toolbox: contains tools for creating and selecting objects, and navigation within your 
drawing 

 
 
Dashboard: a group of the most frequently used palettes: Layers, Style Editor, and 
Styles.  These are docked on the right side of the Impression window upon opening the 
program. 

Layers Palette: similar to the Layer Manager in 
AutoCAD.  Use this palette to turn on/off     , 
lock/unlock      , and pack/unpack      layers.  
Rename layers by double-clicking the layer 
name, and adjust the draw order by dragging 
layers up and down the list. When more than 
one viewport is opened from a drawing file, 

they are listed in the layer palette as “sketches”, each with their own set of layers, 
which makes it easier to change only one sketch at a time.   
 
 
 

Style Editor: used to create and modify 
appearance styles. 
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Styles Palette: contains a library of “appearance styles” (defined 
below), as well as the tools needed to manage styles, and save 
or import new ones. 

 
 
 

 
 
Appearance Style: 

 
Canvas: the drawing area in your Impression file.  The size and orientation of your 
canvas can be set by selecting File>Document Setup 

 
Palettes: Windows that are used to assign or manage different aspects of the 
Impression drawing, such as layers, styles, and blocks.  There are additional palettes 
(other than the three in the dashboard) that can be accessed from the “Palettes” pull-
down menu in the toolbar.   

To open and close them, select and deselect 
them from the menu.  To dock these once they 
are open, simply drag the palette to the right or 
left side of the Impression window.  Adjust the 
transparency of floating palettes by right-clicking 
on the palette title bar. 

   
 
 
 
 
Options: Select Edit>Options to access the Impression options, such as Keyboard 
Shortcuts, Object Snap Settings, Saving and Display options.  
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Interface Quick Tips:  
1. Press the Tab key to toggle the palettes on and off and view your canvas 

in full screen mode 
2. Right-click on a floating palette to adjust its transparency 
3. Press the <F2> key to toggle the properties palette on and off 
4. To access the keyboard shortcuts, select Edit> Options> Keyboard 

Shortcuts 
5. Alt + Z = Zoom Extents 
6. Control + Scroll = rotate canvas 
7. To rotate multiple objects at the same time, but around their respective 

centers: Select objects > press and hold the <Alt> key >  hover just 
outside the corner grip to activate the rotate tool, select and drag the 
rotate icon  

d. Filling in the Blanks 

There are many methods for applying appearance styles to your image.  Based on the 
drawings you typically work with, you’ll find one or more ways that work best for you.  To 
begin, try these options: 

- Area Fill: Select an appearance style and then select the Area Fill Icon.  There 
are four types of area fills. Press the pull-down button beneath the Area Fill Icon 
and choose one of the following: 

 
  

Power Fill:  Fills areas with matching properties.  This is helpful for 
filling multiple areas quickly, with only one click of the mouse. 
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Line and shape tools: Use drawing tools from the toolbox 
(spline, line, and shapes) to create custom fills by 
drawing boundaries that were not contained in your 
DWG or DWF file.  These tools are good for filling in a 
sky or ground (in elevation, section, or 3D views), which 
usually don’t have boundaries drawn in the original file 

 
 

 
 

Drag and drop: When the “Select” tool is active, fill areas 
by dragging an appearance style onto the canvas.  

 
 
 
 

 
 

Assign Style to Selection:  Select an area or geometry on 
the canvas.  Right-click and select “Assign Style to 
Selection”.  Select the desired appearance style from the 
list 

 
 
 
 
 

 
 
Fill by layer (best when layers are organized): Click and 
drag an appearance style over a layer in the Layers 
Palette to fill all objects on that layer. 
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Rendering Tips: 
i. Auto Layer: At the bottom right-hand corner of the Impression window, 

select the “Auto Layer” button.  This will create new layers, named 
“Auto 1”, “Auto 2”, etc, every time a style is applied to an object that is 
different from that object’s layer style.  This is helpful for separating 
objects with different styles, which in turn makes it easier to update 
styles without having to change style overrides individually.  In 
AutoCAD terms, you can think of this as preventing “forced” properties 
(color, linetype, etc) by creating a new layer every time a property is 
changed.    

ii. Layer Exceptions: A layer exception occurs when an object receives a 
different appearance style than the one assigned to that object’s layer.  
This is like a style override.  When a layer is selected, if it contains a 
layer exception, you will see this icon in the style editor:  From here, 
you have the option to view the number of, select, and reset the layer 
exceptions.  

iii. Performance Tuner:  

·  Icon located at the bottom of the screen:  
·  View performance cost of 

each layer 
·  Pack/Unpack layers to 

improve program 
performance 

·  Optimize Style Display: 
Choose settings for how 
Impression displays your 
file as you are working on 
it.  At the bottom of the 
dialog box, notice how 
each display option 
affects program 
performance.  Once Style 
Display has been set, 
quickly turn these settings 
on and off by selecting 
the “Fast Display” button 
at the bottom of the 
Impression window.     
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Endless Possibilities with Custom Styles 
a. Style Organization 

Impression comes with 10 Style Libraries available for you to use when you install the 
program.  It’s important to know where these libraries come from in order to understand the 
organization of styles in Impression.   

 
 

1. Libraries: These are libraries of styles from individual .irf 
files that are referenced each time you open Impression.  
The default ‘new file’ template contains 10 Style 
Libraries.  Right-click on one of these libraries and 
you’ll see there is a check mark next to “Always Keep 
this Library Open”.  Checking this option tells 
Impression to include the Style Library from that file 
every time Impression opens.  By default, the style 
libraries that are loaded when Impression is installed 
are located here:  C:\Program Files\Autodesk 
Impression 3\Libraries\Styles 

 
2. Search Filters:  

a. Saved Styles: Whenever a style from a Library is saved, edited, or used, 
Impression duplicates that style and creates a new one, which is then stored in this 
list.  This allows for the original libraries to remain unaffected each time you edit a 
style.  The only way to alter a style from a library is to edit it within the individual .irf 
file it is located.  

b. In Use Styles: Styles that are currently applied to any geometry in your drawing.  
A check box next to the preview icon of a style means that style has been assigned 
to geometry within the drawing 

c. Create New Filter: Right-click anywhere in the Search Filters section and select 
Create New Filter.  Here, you can create a new search filter based on name, media 
type, and style type.  

 
3. Block Styles: Styles that are applied to inserted blocks are stored here.  They are 

grouped and listed alphabetically by block name. 
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b. Editing Options 

Appearance styles are made up of one or more Style Elements.  A Style Element can be 
one of five Fill Types, a Stroke, or an Effect:  
 
Fill Types: 

 
 

Stroke and Effects: 

 
 

Editing a Style Element: 
 

Select an Appearance Style and then select the 
element you wish to edit in the Style Editor: 

 
Edit, add, or change the order of Style Elements to 
create new Style Appearances (remember, once you 
edit a style from a library, it is duplicated and placed 
into the Saved Styles Search Filter.  The original 
Appearance Style is unaffected). Toggle the On/Off 
buttons to turn on or off individual Style Elements. 

 
 

Globally adjust the hue, rotation, or size of all 
elements within an Appearance Style by selecting 
the arrow next to the style preview in the Style Editor 
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**Style Editing Quick Tips:  

1. For optimal program performance, remember to use Fast Display and the 
Performance Tuner once you’ve applied Appearance styles. 

2. New in Impression 3: Gradient Fills are now adaptive, which means the 
gradient can form to the shape of the area that is being filled! 

3. For a great glass or water effect, add white pencil stroke over blue 
gradient or uniform fills 

4. Add dual roughen effects for an enhanced water color effect 
 
 

c. Style Library Wizard 

The Style Library Wizard is used to generate 
up to 200 variations of a “Starting Style” of 
your choice, enabling you to quickly create 
new styles from just one existing style.  Use 
the results to save a library of custom styles.   
 
       Access from: 

1. Tools menu 
2. Press F7 
3. Select The Style 

Library Wizard icon 
at the bottom of the 
Styles Palette:  

 
Save your custom library by choosing a file location in the “Name and Location” tab, 
under “Save Style Library in”.  This will create a new Impression file that is used to store 
appearance styles.  Refer to section (a) under “Completing a Rendering” in this handout 
to learn how to import your library into a new drawing 
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d. Saving styles 

How To: Create a library of styles 
1. Select a Search Filter from the navigation pane 

OR 
Select individual styles from the Search Filter 

2. Select the “Export Styles” icon on the lower right side of 
the Styles Palette 

3. Save a new Impression file.  This creates a file that 
stores your styles as a new library, which can be linked 
into any drawing 

 
How To: Load your custom library into Impression: 
1. Select the “Link to Styles Library” Icon in the Styles 

Palette 
2. Locate and select the Impression file that is storing your 

custom style library 
3. Choose “Open File as External Library.  The new library 

will be stored in the libraries list in the Styles Palette.  
Styles will not be stored in the new drawing; they will be 
linked to the library’s external Impression file. 

4. Click OK 
OR 

5. Select individual styles from the style library and select 
“Copy Selected Styles to Palette” to load the styles into 
the new drawing (not as a link). Loaded styles will be 
placed in the “Saved Styles” Search Filter in the Styles 
Palette. 

 
**To keep your custom library open every time you start 
Impression, right-click on the library in the Styles Palette, 
and select “Always Keep this Library Open”.  
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Taking it a Step Further with Custom Blocks 
a. Overview of Impression Blocks 

Impression blocks are stylized entourage elements used to give a sense of scale and detail 
to an image.  They are often used repeatedly, can be edited globally, and are stored in 
libraries similar to the way appearance styles are stored. The block palette is used to 
organize, manage, and place blocks within a file.  Open the Block Palette from the Palettes 
menu or by pressing F4 
 
Block Palette: 
 
The Block Palette is set up similar to the Styles Palette.  The 
navigation pane contains a list of libraries linked from external 
impression files, as well as Saved Blocks and In Use Blocks. 
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Block Substitution 

Block Substitution: Stylize existing CAD geometry by replacing linework with a rendered 
Impression block.  To do this, simply drag a block thumbnail from the block palette onto 
a CAD block on the canvas. Make sure the layer you want the block on is current 
 

When dragging a block from the palette to the canvas, the cursor will indicate 
which type of placement you will be creating: 
 

A cursor with a plus sign places a single instance of a block, no 
substitution is made over a CAD block 

 
 

 
A cursor with an arrow places a block substitution, which will replace 
the original CAD block.  In order to ensure you are doing this, place 
the block thumbnail directly over linework from the DWG block. 

 
 

Substitution Dialog: After dragging the new block onto the 
original DWG block, the substitution dialog will display, 
showing the details of the substitution. 

 
Select the “More Properties” arrow to display size and 
variation controls.  Here, you can set Impression to 
vary the scale and rotation of the block for each 
insertion.  This helps give the drawing a more natural 
and random feel. 

 
 

Block Substitution Map: The Substitution Map displays information about blocks that 
have been substituted.  In this palette, you can edit or add block substitutions, as well 
as delete them to return the blocks to their original CAD form.  It is the Block 
Substitution Map that is saved with the Impression file, which allows you to import the 
same block substitutions in other Impression illustrations. 

 

b. Creating New Blocks 

Create your own blocks by using the draw tools and applying appearance styles.  When 
you are finished, select all objects that will be included in the block and select the 
“Create Block from Selection” button; a new block definition is created.    
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c. Editing Blocks 

To change the appearance styles within a block, simply locate the block styles that are 
associated with that block in the Styles Palette.  To change the geometry of the block, 
open the block in the Block Editor: 
 
The Block Editor allows you to open a block in a new window and modify its style and 
geometry.  To open the Block Editor, double-click on the block you would like to edit.   

 

 
 

**Block Quick Tips:  
1. To create a new block using an existing one as a foundation, duplicate the 

original block and then edit the copy.   
2. Trace over imported images to create your own blocks.  It worked when it 

was done by hand and still works today!
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Completing a Rendering 

a. Re-creating your Style 

Impression makes it easy to re-use layer styles and blocks from a previously completed 
rendering.  As long as the layers in the new drawing are set up the same as the completed 
illustration, you can create another rendering in just seconds.  Simply use the Import Styles 
option to choose what rendering properties you would like to apply to the new drawing. 

1. File> Import Maps 
2. Choose an option: Import Style Maps, Block Substitution Maps, or both 

a. These options makes it easy to import style maps from one file, blocks from 
another, or both from the same file 

3. Select file from which style and block substitution maps are to be taken 
 

How To: Create a Master Template: a blank drawing file that contains all appearance styles 
and blocks that are commonly used in your drawings.   

1. Select Options from the Edit pull-down menu 
2. Select Files from the list of options on the left 
3. Under Templates, select “Browse” 
4. Locate your template file and click OK 
5. Select your template file in the list to designate it as the Default Template 

 

b. Export Options 

Converting Impression files to another format is easy – just select “Save As” and 
choose a file format from the file type list.  Here are your options for file conversions: 

 
1. File formats that retain information about layers and views: 

- PSD, 2D DWF 
2. Image files 

- BMP, EPS, JPG, PDF, PNG 
- When saving image files at a high resolution, try to save to 250 dpi instead 

of 300 dpi.  This might save you a lot of conversion time with very little 
loss in resolution 

3. Native Impression file format: IRF (no down-saving available) 
 
Helpful Resources:  

- Impression Community (AutoCAD Exchange): the Impression Community was 
previously located at impression.autodesk.com, but is now on the AutoCAD 
Exchange site at autocad.autodesk.com 
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Demonstrations 
a. Overview of the Interface and opening a DWG 

b. Styles 
i. Create a new style 
ii. Use the Style Import Wizard to create a new library from the new style 
iii. Save a library 
iv. Link the library to a drawing and have it open upon every time Impression opens 
v. Also: create a new library from selecting individual styles 

c. Blocks 
i. Place a block from the Impression library 
ii. Edit the block in the Block Editor 
iii. Create a new block 
iv. Save a block to a library and open in a new file 

 
 Notes: 


